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Overzicht

Modulair ontwerp 
Het systeem Access Professional Edition (hieronder Access PE
genoemd) biedt onafhankelijke toegangscontrole voor kleine en
middelgrote bedrijven. Het bestaat uit meerdere modules:
– LAC-service: een proces dat voortdurend communiceert

met de LAC's (Local Access Controllers - voortaan
controllers genoemd). AMC's (Access Modular Controllers)
worden gebruikt als controllers.

– Configurator
– Personnel Management (Personeelsbeheer)
– Logviewer
– Alarm Management (Alarmbeheer)
– Video Verification (Videoverificatie)

Server- en clientmodules
De modules kunnen worden onderverdeeld in server- en
clientmodules.
Voor de LAC-service moet een continu contact met de
controllers worden onderhouden. De reden hiervoor is ten
eerste dat de LAC-service continu berichten van de controllers
ontvangt m.b.t. bewegingen, aanwezigheid en afwezigheid van
kaarthouders en op de tweede plaats dat deze
gegevenswijzigingen verstuurt, bijv. toewijzing van nieuwe
kaarten aan de controllers, maar vooral ook omdat deze
controles op meerdere niveaus uitvoert
(toegangsvolgordecontroles, anti-passbackcontroles,
willekeurige controles).
De Configurator moet op de server uitgevoerd worden, maar kan
tevens op een client-werkstation worden geïnstalleerd en vanaf
het werkstation worden bediend.
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De modules Personnel Management (Personeelsmanagement)
en LogViewer (Logboekweergave) behoren tot de Client-
component en kunnen ook op de server worden uitgevoerd, of
op een andere pc die over een netwerkverbinding met de server
beschikt.
De volgende controllers kunnen worden gebruikt.
– AMC2 4W (met vier Wiegand-lezerinterfaces) - kan worden

uitgebreid met een AMC2 4W-EXT
– AMC2 4R4 (met vier RS485-lezerinterfaces)
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Algemeen

Inleiding
Access PE is een toegangscontrolesysteem dat is ontworpen om
kleine en middelgrote installaties optimale veiligheid en
flexibiliteit te bieden.
De stabiliteit en uitbreidbaarheid van Access PE is gebaseerd op
een ontwerp met drie lagen: de eerste laag is het
beheerdersniveau met de besturingsservices. Alle
beheerderstaken worden op dit niveau uitgevoerd, zoals het
registreren van nieuwe kaarten of het toewijzen van
toegangsrechten.
De tweede laag wordt gevormd door de Local Access
Controllers (LAC's), die de verschillende groepen deuren of
ingangen beheren. Zelfs wanneer het systeem offline is, kan een
LAC onafhankelijk beslissingen nemen over toegangscontrole.
LAC's zijn verantwoordelijk voor de bediening van de ingangen,
het bepalen van openingstijden, of verzoeken om PIN-codes bij
cruciale toegangspunten.
De derde laag bestaat uit kaartlezers.
De communicatie tussen client, server en kaarthouders is met
AES versleuteld.
Met de Access PE-versie voor meerdere gebruikers kunt u met
meerdere werkstations het systeem besturen. Aanpasbare
gebruikersrechtniveaus regelen de toegang en garanderen de
veiligheid. Hierdoor is het bijvoorbeeld mogelijk om vanaf het
ene werkstation kaartgegevens bij te werken, terwijl vanaf een
ander werkstation wordt gecontroleerd of een bepaalde
werknemer in het gebouw aanwezig is.
Access PE biedt een uitzonderlijk flexibele configuratie van
toegangsrechten, tijdmodellen en toegangsparameters. De
volgende lijst geeft een overzicht van de belangrijkste functies:
Snelle en eenvoudige toewijzing van kaarten
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Kaarten (max. drie) kunnen handmatig aan personen worden
toegewezen of met behulp van een dialooglezer die via een
seriële verbinding is aangesloten op een pc. Alle toegewezen
kaarten zijn actief. Bij het upgraden van een kaart wordt de
oude kaart automatisch overschreven en ongeldig gemaakt. Dit
betekent dat oude kaarten geen toegang meer bieden, zelfs als
de verantwoordelijke persoon de kaart vergat te annuleren of er
niet in is geslaagd dit te doen.
Toegangsrechten (inclusief groepsrechten)
Elke persoon kan groepsrechten overnemen naast de individuele
rechten die aan hem zijn toegewezen. Rechten kunnen gebieds-
en tijdgebonden zijn en met een nauwkeurigheid van één minuut
worden beperkt. Groepsrechten kunnen worden gebruikt om
toegangsrechten toe te wijzen aan en te beperken voor een of
meer kaarthouders tegelijk. Groepsrechten kunnen afhankelijk
gemaakt worden van tijdmodellen die de toegang beperken tot
bepaalde tijden van de dag.
Toegangsregistratie
Door gebieden te definiëren kunt u controleren of het juiste
traject wordt gevolgd en dit wanneer nodig afdwingen. Zelfs
zonder controle maakt deze configuratie het mogelijk om de
locatie van een kaarthouder weer te geven.
Anti-Passback
Wanneer een kaart gelezen is, kan deze voor een gedefinieerde
periode geblokkeerd worden zodat hij niet opnieuw gebruikt kan
worden voor toegang in dezelfde toegangszone. Op die manier
kan "passback" worden voorkomen, waarbij een gebruiker zijn
kaart over een barrière aan een andere, niet-geautoriseerde
persoon geeft om deze toegang te bieden.
Automatisch annuleren van kaarten na de einddatum
Bezoekers en tijdelijk personeel hebben vaak slechts een
beperkte periode toegang nodig.
Kaarten kunnen voor een specifieke periode worden
geregistreerd, zodat ze automatisch ongeldig worden nadat de
betreffende periode is verstreken.
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Tijdmodellen en dagmodellen
Aan een kaarthouder kunnen specifieke tijdmodellen
toegewezen worden, die de toegangsuren voor die persoon
bepalen. Tijdmodellen kunnen flexibel gedefinieerd worden door
gebruik te maken van dagmodellen die bepalen hoe specifieke
weekdagen, weekends, feestdagen en bijzondere dagen afwijken
van normale werkdagen.
Identificatie via PIN-code
Een persoon kan in plaats van een kaart een speciale PIN-code
gebruiken om naar binnen te gaan.
Verificatie via PIN-code
De toegang tot bijzonder vertrouwelijke gebieden kan worden
beperkt met behulp van extra PIN-codes. Deze beveiliging kan
op haar beurt afhankelijk gemaakt worden van tijdmodellen,
zodat een PIN-code bijvoorbeeld alleen vereist is gedurende
feestdagen of buiten normale werktijden.
Flexibel deurbeheer
Flexibel definiëren van parameters voor afzonderlijke
deurmodellen maakt een optimaal evenwicht tussen veiligheid
en comfort mogelijk. De alarmonderdrukkingsperiode kan per
deur worden ingesteld om te bepalen hoe lang een deur
geopend mag blijven. Na het verstrijken van deze periode kan
het toegangspunt desgewenst worden vergrendeld in
combinatie met een alarmsysteem.
Periodiek vrijgeven van deur
U kunt de toegang vergemakkelijken door deuralarmen te
onderdrukken om deuren gedurende een bepaalde periode vrij
te geven. De vrijgaveperiodes van deuren kunnen handmatig of
automatisch via een tijdmodel worden gedefinieerd.
Tijd en aanwezigheid
Voor toegangszones kunnen parameters gedefinieerd worden
voor het registreren van de binnenkomst en het vertrek van
personen ten behoeve van het tijds- en aanwezigheidsbeheer.
Type ID-kaart
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De grafische invoegmodule Card Personalization (CP) is
volledig in het toegangscontrolesysteem geïntegreerd zodat de
operator kaarten kan maken zonder tussen verschillende
toepassingen te hoeven schakelen.
Toewijzen van foto's
Zelfs als de invoegmodule Card Personalization (CP) niet is
geactiveerd, blijft het mogelijk om fotografische identificatie te
importeren en aan kaarthouders te koppelen.
Offline locking system (Offline-afsluitsysteem)
Gebieden die om een bepaalde reden niet zijn afgesloten door
het online toegangscontrolesysteem met hoge beschikbaarheid,
kunnen offline alsnog worden afgesloten.
Beheer van video-apparatuur
Ingangen kunnen extra worden voorzien van camera's om de
bewegingen van aanwezige personen te registreren en te volgen.
 

Aanmelden gebruiker
De volgende toepassingen zijn beschikbaar. Raadpleeg de
betreffende gebruikershandleidingen voor meer informatie:

Personnel Management
(Personeelsbeheer)

Configurator

Logviewer (Logboekweergave)

2.2
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Map and Alarm Management (Plattegrond-
en alarmbeheer)

Video Verification (Videoverificatie)

Bericht!

Aanmelden op de client is alleen mogelijk als de LAC-service

wordt uitgevoerd op de server.

Aanmelden op client
De toepassingen van het systeem zijn beveiligd tegen niet-
geautoriseerd gebruik. De standaardwachtwoorden bij het
eerste gebruik zijn:
– Gebruikersnaam: bosch
– Wachtwoord: bosch

Na het invoeren van een gebruikersnaam en wachtwoord wordt
de knop Change Password (Wachtwoord wijzigen) actief.
Na drie mislukte pogingen duurt het enige tijd voordat opnieuw
kan worden aangemeld. Dit geldt voor de knoppen "Start the
Application" (Toepassing starten) en "Change Password"
(Wachtwoord wijzigen).
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In de bovenste keuzelijst kunt u de gewenste taal voor interactie
selecteren. Standaard is dat de taal die is gebruikt om de
toepassing te installeren. Als een volgende gebruiker de
toepassing niet opnieuw opstart, blijft de eerder ingestelde taal
actief. Het is dan mogelijk dat er een dialoogvenster in een
ongewenste taal wordt weergegeven. Om dit te voorkomen,
dient u zich nogmaals bij Access PE aan te melden.
Access PE toepassingen kunnen worden uitgevoerd in de
volgende talen:
– Engels
– Duits
– Frans
– Japans
– Russisch
– Pools
– Chinees (PRC)
– Nederlands
– Spaans
– Portugees (Brazilië)

Bericht!

Alle voorzieningen zoals apparaatnamen, labels, modellen en

gebruikersautorisatieschema's worden weergegeven in de taal

waarin ze zijn ingevoerd. Knoppen en labels die afhankelijk zijn

van het besturingssysteem, worden mogelijk weergegeven in de

taal van het besturingssysteem.

Nadat u op de knop Change Password (Wachtwoord wijzigen)
hebt geklikt, voert u een nieuwe gebruikersnaam en een nieuw
wachtwoord in dit dialoogvenster in:
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Bericht!

Vergeet niet het wachtwoord te wijzigen!

Met de knop Start the application (Toepassing starten) worden
de rechten van de gebruiker gecontroleerd en op basis hiervan
de toepassing gestart. Als het systeem de aanmeldingsgegevens
niet kan verifiëren, verschijnt het volgende foutbericht: Wrong
username or password! (Gebruiker of wachtwoord is onjuist).
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Indeling van de Log Viewer
(Logboekweergave)

1 = Menubalk - Bevat alle dialoogvensterfuncties
gerangschikt in menu's.

2 = Werkbalk - Bevat de belangrijkste
dialoogvensterfuncties in de vorm van knoppen.

3 = Titelbalk - Komt overeen met de standaardvensters
van Windows en bevat knoppen voor het
minimaliseren en sluiten van het
hoofddialoogvenster. De naam van de huidige
gebruiker wordt tussen vierkante haakjes
weergegeven.

4 = Apparaatstatus - Toont de geconfigureerde
apparaten en ingangen en hun verbindingsstatus.

5 = Meldingenlijst - Lijst van meldingen die tot nu toe
zijn ontvangen. De weergave kan gewijzigd worden
door middel van specifieke filterinstellingen.

6 = Filterselectie - Vooraf gedefinieerde en aangepaste
filters kunnen geselecteerd worden uit de keuzelijst.

2.3
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7 = Alarmactivering - Activeren/deactiveren van alarmen
om meldingen te genereren. Een inkomende melding
kan vergezeld gaan van een geluidssignaal.

8 = Statusbalk - Datums van de geopende
logboekbestanden. Status van de LAC-service.
Alarminstellingen.

Pictogramknoppen
De volgende functies zijn beschikbaar voor logboekevaluatie via
menu's en pictogramknoppen.

Menu Functie Pictogram
knop

Beschrijving

File
(Bestand)

Print...
(Afdrukken.
..)

De weergegeven
logboekberichten
afdrukken

Afsluiten  De toepassing
LogViewer
(Logboekweergave)
sluiten.

Filter Filter
definition
(Filterdefin
itie)

Het dialoogvenster
openen voor het
filteren van
meldingen.

2.4
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Menu Functie Pictogram
knop

Beschrijving

Continuous
mode on
(Continu-
modus
aan)

Continue
meldingweergave
starten. Deze knop is
alleen actief als de
functie nog niet is
ingeschakeld en als
het meldingenfilter op
de huidige dag is
ingesteld.
Continue
meldingweergave is
de
standaardinstelling.

Continuous
mode off
(Continu-
modus uit)

De continue
meldingweergave
pauzeren. Dit
pictogram is alleen
actief als de continue
meldingweergave
actief is.

Events
previous
day
(Gebeurten
issen
vorige dag)

Schakelen naar
meldingen van de
vorige dag.
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Menu Functie Pictogram
knop

Beschrijving

Events next
day
(Gebeurten
issen
volgende
dag)

Schakelen naar
meldingen van de
volgende dag.

View
(Beeld)

Symbol bar
(Werkbalk)

 De werkbalk
verbergen/weergeven.
Standaard =
weergeven.

Status bar
(Statusbalk
)

 De statusbalk
verbergen/weergeven.
Standaard =
weergeven.

zonder een menuoptie

   

   

? (Help) Help topics
(Help-
onderwerp
en)

Dit Help-bestand
openen.

About
LogViewer
(Info over
LogViewer)

 Help-info over Access
PE LogViewer openen.
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Logboek
Alle processen (inclusief bijvoorbeeld aan- en afmeldgegevens
voor gebruikers op een werkstation) in het Access PE
toegangscontrolesysteem worden doorgestuurd met behulp van
overeenkomstige berichten en opgeslagen in de
gebeurtenissenlogboeken. U kunt veiligheidgerelateerde
berichten (alarmmeldingen) onderscheiden van puur
informatiegerelateerde items door deze te classificeren.
Hierdoor kunt u eenvoudiger eventuele verdere maatregelen
implementeren.
Voor een heldere presentatie met de optie om te filteren op
belangrijke berichten en dialoogvenstergebruikers te
waarschuwen kunt u het dialoogvenster (Logboekweergave) op
elk werkstation installeren en starten, mits de gebruikersrechten
van de aangemelde persoon dit toestaan.
 

Meldingenlijst
De hoofdfunctie van LogViewer is het weergeven van
logboekberichten, zowel huidige als oude.

Standaard wordt het weergavescherm continu geactualiseerd
met binnenkomende meldingen. De relevante pictogramknoppen
verschijnen met de volgende statussen: .

3
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Bij het opstarten van LogViewer worden de meldingen van de
huidige dag weergegeven. De meldingen van vorige dagen

kunnen worden weergegeven met de knop . Een
logboekbestand met de bestandsnaamindeling
Msg<yyyymmdd>.log wordt iedere dag gemaakt in de volgende
map: C:\BOSCH\Access Professional Edition\Data\MsgLog. Al
deze bestanden kunnen worden weergegeven in LogViewer.
De meldingenlijst bevat kolommen met de volgende informatie:

Kolom Beschrijving

(geen titel) Symbolische weergave van de
meldingencategorie zoals gedefinieerd
in Configurator.

(geen titel) Identificatie van de berichten waarvoor
een video-opname bestaat: 

Datum Datum en tijdstip waarop de melding
werd gegenereerd.

LAC / PC Bron van de melding: naam van de
controller of het werkstation.

Reader / Login
(Lezer /
Aanmelding)

Bron van de melding als de controller
de melding alleen maar heeft
doorgegeven. Als de bron een
werkstation is, de naam van de
gebruiker van het werkstation.

Location (Door) /
Program (Plaats
(Deur) /
Programma)

Naam van ingang, signaal of andere
installatie. Als het een werkstation
betreft, de naam van de toepassing.

Nr. Berichtnummer volgens lijst met
gebeurtenissenlogboekteksten in de
Configurator.
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Kolom Beschrijving

Melding Meldingstekst zoals gedefinieerd in
Configurator.

Card No. (Kaartnr.) Kaartnummer (voor zover dit voor het
systeem leesbaar en bekend was).

Last name
(Achternaam)

Achternaam van de kaarthouder.

First name
(Voornaam)

Voornaam van de kaarthouder.

Company / Dept.
(Bedrijf / Afd.)

Bedrijf / Afdeling van de kaarthouder.

Local date (Lokale
tijd)

Als de AMC zich in een andere tijdzone
bevindt, wordt hier de lokale
aanmaaktijd van het bericht getoond.

De meldingenlijst kan naar wens worden aangepast. De volgorde
van de kolommen kan bijvoorbeeld worden gewijzigd door de
kolomkoppen naar de gewenste plaats te slepen. Zo kunt u de
kolommen die u het belangrijkst vindt vooraan plaatsen.
Om de meldingen die u interesseren effectiever te vinden, kunt
u in de lijstweergave sorteren (schakelen tussen oplopende of
aflopende volgorde) door te dubbelklikken op een willekeurige
kolomkop.

Bericht!

Afhankelijk van de toegewezen rechten van de gebruiker zullen

de weergegeven meldingen meer of minder uitgebreid zijn. Voor

gebruikers die alleen gemachtigd zijn om hun eigen meldingen

te bekijken, worden alle meldingen van andere personen

gefilterd. Voor gebruikers die niet gemachtigd zijn om

personeelsgegevens te bekijken, zullen de laatste vier

kolommen van de inhoud leeg zijn.
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Meldingen filteren
Klik, om de weergave te beperken tot meldingen die voldoen aan
specifieke criteria, op Filter > Filter Definition (Filterdefinitie)

of op de pictogramknop  in de werkbalk. Er wordt dan een
dialoogvenster geopend om de filtercriteria te kiezen.

U kunt meldingen filteren volgens de volgende criteria:

 

3.2
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Filtercriterium Beschrijving Notes
(Opmerkingen)

Time period
from ... to...
(Periode van ...
tot...)

Door hier datums in
te voeren, kan de
weergave beperkt
worden tot een
bepaalde periode. De
huidige datum kan als
laatste datum worden
ingevoerd.
Door andere datums
in te voeren voor de
weergave van
gebeurtenissen in het
verleden, kunt u de
huidige weergave van
gegevens wijzigen of
uitbreiden.

Omdat alle
logboekbestanden
gelezen worden, is
het af te raden om
een zeer lange
weergaveperiode
op te geven.
Afhankelijk van de
grootte van de
logboekbestanden,
adviseren wij
maximaal een
periode van in
totaal een maand
op te geven.

Name (Naam) De weergave kan
beperkt worden tot
personen waarvan de
namen overeenkomen
met de filtercriteria.

De filters Name
(Naam), Company/
Dept. (Bedrijf/
Afdeling) en card
(kaart) kunnen niet
in combinatie met
elkaar worden
gebruikt.

Company/Dept.
(Bedrijf/Afd.)

De weergave kan
beperkt worden tot
personen van
opgegeven bedrijven
of afdelingen.
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Filtercriterium Beschrijving Notes
(Opmerkingen)

card (kaart) De weergave kan
beperkt worden tot
personen waarvan de
kaartnummers binnen
een opgegeven bereik
liggen. Bijv. alle
kaartnummers die
beginnen met een 6.

Entrances
(Ingangen)

Beperken van de
weergave tot
berichten die
betrekking hebben op
specifieke ingangen.

 

Messages
(Meldingen)

Beperken van de
weergave tot
bepaalde typen
meldingen.

 

Alarm siren
with .wav file
(Alarmsirene
met .wav-
bestand)

Alarmmeldingen
kunnen benadrukt
worden door het
weergeven van een
akoestisch signaal.
Ieder willekeurig
audiobestand in het
systeem kan gekozen
worden om bij een
alarm te worden
weergegeven.
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Bericht!

Een filter is alleen actief zolang de desbetreffende toepassing

actief is. De standaardinstellingen (bijv. huidige datum, geen

filtering) worden hersteld zodra LogViewer opnieuw wordt

gestart.

 

Filters opslaan en opnieuw laden
Om te voorkomen dat filters opnieuw gedefinieerd moeten
worden telkens wanneer het programma wordt gestart, stelt
LogViewer iedere gebruiker in staat om geprefereerde
filterinstellingen op te slaan en opnieuw te laden.
Nadat u uw persoonlijke filterinstellingen hebt gedefinieerd,
kunt u deze opslaan door te klikken op Save... (Opslaan)
onderaan in het dialoogvenster. Standaard worden
filterinstellingen met een naam (<filename>.flt) opgeslagen in C:
\BOSCH\Access Professional Edition\Data\Cfg

Opgeslagen filterinstellingen kunnen opnieuw worden geladen
en geactiveerd door ze op te vragen in de keuzelijst Filter in de
linkerbenedenhoek.
Om een eerder gedefinieerd filter te controleren en/of te
bewerken, dient u dit eerst te laden en te openen door te

klikken op  en vervolgens op Load... (Laden). in het
dialoogvenster Filter view (Filterweergave).
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De geladen filterinstellingen kunnen nu gecontroleerd, gewijzigd
en uiteindelijk toegepast worden op de actieve toepassing door
te klikken op OK.
 

Alarmmodus activeren
Door te klikken op Activate alarm (Alarm activeren), of door een
opgeslagen filter met alarmactivering te selecteren, wordt het
LogViewer-venster gesloten en in de stand-by-status gezet. Het
verschijnt op de systeembalk als het pictogram . Wanneer de
muisaanwijzer daarop wordt geplaatst, verschijnt de volgende
tekst: Access PE: Wait for alarm (Wacht op alarm) Door op het
pictogram te dubbelklikken kan het dialoogvenster op elk
moment weer op de voorgrond worden geplaatst.

Bericht!

Zolang de Alarmmodus actief is, kan de toepassing niet

gesloten worden via de knop x in de titelbalk of via File > Exit

(Bestand > Afsluiten). In plaats daarvan keert LogViewer terug

in de stand-by-modus.

Wanneer een melding wordt ontvangen, keert het hoofdvenster
terug op de voorgrond.
Zolang het vakje Sound Off (Geluid uit) niet is geactiveerd,
wordt het binnenkomende alarm vergezeld door een akoestisch
signaal.
 

3.3
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Rapporten: paginaweergave
Het is mogelijk filters in te stellen om de rapportinhoud te
beperken tot een subset. Als u geen filter instelt, worden alle
gegevens opgenomen in het rapport. Klik op de knop Search
(Zoeken) om het ophalen van gegevens te starten en ze weer te
geven in een voorbeeldvenster.

Bericht!

Bij het wijzigen van de filtercriteria wordt het aanbevolen de

knop Clear form (Formulier wissen) te gebruiken om

onbedoeld filteren en misleidende rapporten te voorkomen.

Geopende logboekbestanden kunnen worden opgeslagen of
worden afgedrukt. Via het menu-onderdeel File > Print (Bestand

> Afdrukken of de knop  wordt een voorbeeld geopend.
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Bericht!

Alle geopende logboekbestanden worden afgedrukt.

Sluit alle bestanden die niet hoeven te worden afgedrukt, of

beperk de selectie voor de belangrijke berichten.

 
De rapportpaginaweergave biedt een aantal functies voor het
wijzigen en bedienen van de weergave:

Knop Betekenis Beschrijving

Exporteren De lijst kan voor verdere
verwerking worden geëxporteerd
naar een bestand. De volgende
bestandsindelingen zijn
beschikbaar:
Acrobat Portable Document
Format (PDF)
Door komma's gescheiden
waarden (CSV)

Afdrukken Hiermee drukt u het rapport af via
een afdrukvenster waarin u een
standaardprinter kunt instellen.

Pagina
selecteren

Met de pijlknoppen gaat u naar de
eerste, vorige, volgende of laatste
pagina van het rapport. Dit
besturingselement geeft ook het
huidige paginanummer en het
totale aantal pagina's in het
rapport weer.

 

26 nl | Logboek
Access Professional

Edition

2017-08 | APE-UL | Log Viewer Bosch Access Systems GmbH



Knop Betekenis Beschrijving

Aantal
pagina´s

Vraagt om de huidige pagina en
het totale aantal pagina's.

In-/
uitzoomen

U kunt desgewenst een andere
schaal dan de standaardschaal
van de weergave (100%)
selecteren.

Lijsten exporteren
Druk op de knop  om een dialoogvenster te openen waarin de
exportcriteria kunnen worden ingevoerd.

Het selectielijstveld Format (Formaat) biedt de
uitgangsformaten .pdf (voor het doorsturen en archiveren van
specifieke zoekresultaten) en .csv (voor verdere
gegevensverwerking).
Wanneer gegevens naar een csv-bestand worden geëxporteerd,
kunnen deze in zekere mate verder worden verwerkt.
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Naast de begrenzings- en exportmodus kunt u ook rapport- en
paginasecties (kolomkoppen en paginadetails) en groepsecties
(geselecteerde gegevens) van export uitsluiten of isoleren.
U kunt een van de volgende opties gebruiken als Destination
(Bestemming).
– Application (Toepassing) — opent het bestand met de juiste

toepassing. Deze toepassing moet ook op de computer
worden geïnstalleerd. Pdf-bestanden worden geopend met
Adobe Acrobat Reader en csv-bestanden worden geopend
met MS Excel.

– Disk file (Schijfbestand) (standaard) — opent een Explorer-
dialoogvenster waarin u de gewenste map kunt selecteren.
Er wordt een naam voorgesteld waarmee het bestand kan
worden opgeslagen.

– Exchange folder (Exchange-map) — het bestand kan direct
naar een MS Outlook-ontvanger worden verzonden.

– Lotus Domino Mail — het bestand kan direct naar een Lotus
Mail-ontvanger worden verzonden.
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Video afspelen
Als een bewakingscamera geconfigureerd is voor een toegang,
worden alle berichten voor deze toegang gemarkeerd met een

 in het logboekvenster. Afhankelijk van de configuratie van
het videoapparaat betekent dit dat videosequenties van de
geselecteerde bewakingscamera beschikbaar zijn en kunnen
worden afgespeeld, te beginnen op het tijdstip waarop het
bericht is geactiveerd.
Wanneer u een bericht selecteert met camera-identificatie,

wordt de knop  in de werkbalk geactiveerd. Druk op deze
knop om het dialoogvenster Video afspelen te openen.

Video afspelen
Wanneer u het dialoogvenster Video afspelen opent, wordt het
afspelen standaard 20 seconden voordat het alarm geactiveerd
is begonnen en beëindigd na 120 seconden.
U kunt het beginpunt en de duur van de sequenties
configureren, die worden ingesteld na activering van een alarm.
Opmerkingen over het gebruik van het dialoogvenster:

3.5
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De voortgangsweergave toont hoe ver de
opname gedurende de ingestelde periode
is gevorderd.

Instelbare velden voor begin en einde van
de periode voor de weer te geven
videosequentie.

De door u ingestelde begin- en eindtijden
worden alleen geactiveerd nadat u deze
hebt bevestigd door op deze knop te
drukken.

Start de videosequentie opnieuw nadat u
deze met de pauzeknop hebt onderbroken,
of verlaagt de afspeelsnelheid als u de
snelle modus hebt geactiveerd.

Snelle modus — spoelt de videosequentie
snel vooruit.

Pauze — onderbreekt de weergave —
genereert een momentopname.

Springt naar het begin van de sequentie en
begint opnieuw met afspelen.

Springt naar de activeringstijd van het
alarm waarvoor de video-opname was
geopend.
Opmerking: Dit is alleen mogelijk als de
alarmtijd zich binnen het ingestelde interval
bevindt.

Sluit het dialoogvenster Video playback
(Video afspelen)
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UL 294-vereisten
Functies die niet zijn geëvalueerd door UL:
– Het systeem van videoverificatie
– Plattegrondweergave en alarmbeheer met plattegrond- en

videoverificatie
– Video Player
– Badge Designer
– De Delta 1200 Series
– Rosslare ARD-1200EM Series
– LAC-controllers
– LACi-controllers
– APC-AMC2-4R4CF-controllers

– BG 900-lezer met interfaceprotocol
– L-BUS-lezer met interfaceprotocol

– IDS van beveiligingssysteem - In-/uitschakelen van alarm
– Liftgebruik
– Teksten
– Logboek
– Personeelsbeheer en rapporten
– Gebruik van inbraakalarm

Functies die zijn geëvalueerd door UL:
– 26-bits Wiegand-formaatlezers
– AMC2-controllers:

– APC-AMC2-4WCF
– API-AMC2-4WE
– API-AMC2-8IOE
– API-AMC2-16IOE

– APE-SW als aanvullende bewakingsapparatuur
De volgende Bosch-kaartlezers zijn door UL geëvalueerd voor
compatibiliteit met het APE-SW-softwaresysteem van Bosch:
– LECTUS secure 1000 WI
– LECTUS secure 4000 WI
– LECTUS secure 5000 WI

4
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